HP IT Executive Scorecard

For the Windows ® operating system

Software Version: 9.30

Content Extension Guide

Document Release Date: May 2012

Software Release Date: May 2012



Content Extension Guide

Legal Notices
Warranty

The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial ltems are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice

© Copyright 2011-2012 Hewlett-Packard Development Company, L.P.

Trademark Notices

» Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.
* AMD and the AMD Arrow symbol are trademarks of Advanced Micro Devices, Inc.
* Google™ and Google Maps ™ are trademarks of Google Inc.

* Intel®, Itanium®, Pentium®, and Intel® Xeon® are trademarks of Intel Corporation in the U.S.
and other countries.

» Javais aregistered trademark of Oracle and/or its affiliates.

* Microsoft®, Windows®, Windows NT®, Windows® XP, Windows Vista® and SQL Server® are
U.S. registered trademarks of Microsoft Corporation.

* Oracle is aregistered trademark of Oracle Corporation and/or its affiliates.

Page 2 of 43 HP IT Executive Scorecard (9.30)



Content Extension Guide

Documentation Updates

The title page of this document contains the following identifying information:

o Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

« Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

e Search for knowledge documents of interest

e Submit and track support cases and enhancement requests
o Download software patches

o Manage support contracts

e Look up HP support contacts

« Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Develop New Content Using the Integrated
Development Environment

The IDE enables you to develop new entities, as well as extend existing content using the Architect
and Engineer contexts.

The Integrated Development Environment (IDE) allows you to develop content and model Data
Warehouse schema. Once the entities are defined and mapped, they are saved in a JSON file and
run through the ETL Gen to produce the metadata and workflows. You can then package the data
into Content Packs for use in the Data Warehouse.

Learn More

Entity

An entity in a database definition is a table, or the schema for the table. Each column of a table has
a name and a data type associated with it.

Context

A context in the IDE is the project you create in order to perform content extension and definition.
The IDE contains the Architect and Engineer Contexts.

Content Packs

The connection from the data source to the Data Warehouse is called a Content Pack. Each
Content Pack extracts the data from the specific data source. Content Packs contain all the
artifacts needed to connect to the relevant data source and gather data from that data source.

Tasks

This following describes the various IDE processes:
"IDE Main Page and End-to-End Flow" on page 10
"Getting Started " on next page

"Discover Data Evidence" on page 14

"Define New Content Pack Project" on page 15
"Define the Target Model" on page 17

"Perform Architect Context IDE Tasks" on page 18
"Perform Engineer Context IDE Tasks" on page 27
"Manage Validation" on page 39

"Generate the ETL" on page 40
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Getting Started

This document assumes basic data warehouse modeling knowledge, understanding of the ETL
concepts, good familiarity with databases, as well as SAP Business Objects Data Services. When
creating or extending content make sure that you have set up Executive Scorecard as well as
installed the contents of the IDE DVD. For IT Executive Scorecard installation and administration
details, see the Administrator Guide.

Required for DWH Architects

« Understanding of Business Intelligence tools, data warehouse modeling and database design
principles.

e XS DWH Target schema.

Required for DWH ETL Engineers

¢ Understanding ETL principles.

o Experience with BODS.

o Familiarity with the source schema.

Required for DWH Integration Engineers

e Java programming sKkills

Prerequisite knowledge for performing content development tasks:
o HP Unified Data Model (UDM).

o Target Model: The existing supported model of the DWH

o Basic architecture of the data warehouse and the advantages of the templates.
o Basic familiarity with the Integrated Development Environment (IDE).

+ BODS and data modeling.

IDE DVD Set up

The IDE DVD contains the following folders:
o IDE: Unzip the file and double-click eclipse.exe to install the IDE Eclipse application.

e ETL-Gen: Must be installed on an Apache Tomcat server. It is recommended to copy the file
under the existing Tomcat directory on the DWH server. The path is Start Menu > All
Programs > Tomcat > Tomcat Directory.

¢ IDE Content: Contains the OOTB Content Packs.

¢ Tools: Contains the packaging tools used to create a new Content Pack to put in the DWH and
activate, after the IDE content extension process.
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Planning Phase

The development of new content comprises the following steps:
1. Data Evidence: Understanding what data needs to be included.
Define new Content Pack folders if required.
Modeling: The architect creates the Target model.
Data Source Integration: The engineer maps the data from the Source to Target.
ETL development and generation.
ETL orchestration and management through ABC.
Consolidation

Universe and Semantic layer adjustments.

© ® N o 0o > w0 N

KPls additions and modifications.
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IDE Main Page and End-to-End Flow

The IDE main page enables you to create contexts for the purpose of extending content to entities.
The following describes the IDE main page and icons as well as the tasks and flow of the IDE
process.

The IDE Eclipse Main Page

The IDE requires basic knowledge of Eclipse and its capabilities. The following describes the IDE
layout and icons. Select Window > Show View to add to and change the view of the various tabs

and areas.
2 Java - Eclipse SDK s o = s
File Edit Mavigate Search Project DW Content Run Window  Help
i ko 5 00 BHG- Be i E B h={EANE)
f& PackageE 33~ T O an
BE
12 cp-alm |
L5 cp-alm-11-generic
2 cp-alt

& cp-alt-L-oracle
& cp-alt-9.0-oracle

2 cp-am

2 cp-am-5.l-mssql

2 cp-am-5.l-oracle

2 cp-am-5.2-mssql

& cpam-5.2-oracle

& cp-bsm

& cp-bsm-9.01-bsm

2 cp-bsm-8.01-ucmdb ||
2 cp-core

= cp-dp

& cp-dp-.2-generic

I cpedp-6.2-oracle

= cpena

2 tp-na-9.1-generic

L3 cp-nnm |
2 cp-nnm-9-1-generic ||
& cp-ppm |
& cp-ppm-3.0-oracle

& cp-ppm-3.1-oracle

1= cpesa

& cpesa-.00-generic

I cpesm

& cp-sm-T11-mssql

2 cp-sm-T11-oracle

& cposm-0.2-mssql

& cpsm-9.2-oracle

3 cptest
1 cp-test-2.0-generic
& cp-ucmdb-3i-ucmdt |l Problems | Properties &2 . 9] Error Log| BE

| Property Value
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

Ul Element Description

Package Explorer A list all of the available loaded Content
Packs and Contexts.

<Main Workspace> A workspace is the general umbrella for
managing resources in the Eclipse
Platform

Problems Displays validation errors and warnings.

Properties Displays property tabs according to the
selected entity in the context.

Error Log Reports system errors.

" Report a Bug. Click and select the
packages that are problematic and send
the bug report.

J50N Generate JSON file. Click to begin the

ETL Gen process. For details, see
"Generate the ETL" on page 40.

=] Save. Click to validate and save your
mappings and configurations.
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IDE Icons

Icon Description

Indicates a Fact entity column.

il

E Indicates a Dimension entity column.

= | Indicates an association between Fact and Dimension entities.

n"“_,--] Indicates an association between Dimension entities.
R

ﬁ Indicates a column which exists both as a Fact and as a Dimension.

4 | Indicates an column before it has been designated a Fact or Dimension entity.

Py Warning that appears when you save a problematic change to a mode that might cause an
error at a later stage in the process. You can view the details by hovering over the icon on
the model or in the Problems tab.

(%] Error that appears when there is a design problem with your model in a context. For

example, the length of a column is too long. You can view the details by hovering over the
icon on the model or in the Problems tab.
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The IDE End-to-End Flowchart

The following illustrates the typical tasks and procedures in the IDE. The tasks correspond to the
relevant tasks in the Architect and Engineer contexts.

Develop New Entities
using the IDE

New
Yes Content No—l
Create New Integration Use Existing
or Source Content Pack Content Pack
Folder Folder
| I
» Add New v

Target Entity?

k.

Define New Target Entity in
the Architect Context

Extend an
QOOTB Entity?

Add New Source
Entity?

Yes

Load Existing OOTB Target
Entity in the Architect Context

Yes

] }

Define New Target Entity _| Load Existing Target Entity in the
in the Architect Context Engineer Context

k.

Define New
Integration?

Yes

A
Define New Integration in Load Existing Integration in
the Engineer Context the Engineer Context

r

Define New Source in
the Engineer Context

L 4

Generate Solution
Metadata (JSON format)
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Discover Data Evidence

It is necessary to understand and be familiar with the new data you want to develop. When there is
a new source system involved, you must first understand how the data from the source appears
and operates.

Data Evidence can be done as follows:
1. Understand how to extract the data.
2. Take sample files extracted from the source.

3. Examine different fields this source provides: It is important to recognize the fields and data
which come from the source and to define the names of the fields as the source tables.

4. Define and plan in advance which extractors provide data for specific entities.

5. Understand variety, different lists of values, end-cases.

6. Observe data behavior over time:
a. Understand what happens with data across time — is it the same file, only different dates?
b. Sizes of rows and volumes by types of customers.
c. ldentify how this data correlates with existing data in the Data Warehouse.

At the end you should have a good sense of what this data looks like and how to develop
extraction code for it.

7. ldentify:
a. What is the required data to be available in the Target schema to support required KPls.
b. What is the data that can come out of the source (depending on technology).

c. Where do they meet in the middle, so eventually we have the outcomes of the extracted
data and the DWH Target model.

d. Forwhich columns do you want to preserve history.

After mapping between the Source and the Target, the design process is complete.
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Define New Content Pack Project

The IDE comes with OOTB Content Packs which you can use to add and extend content. You can
also create projects based on data from new content folders, which you must manually add and
define.

To create new projects from content folders:
1. Select File > New > Other > DWH IDE > Content Pack.
2. Select the type of project: Source, Integration, or Target.

3. Enter the project name for the new content.

= Source Project L= sl 2%

Source Project

Create a new source content pack project,

[ o
Project name:
[¥] Use default location
Chdsershsussmantorkspace Browese.,.
Working sets
[T &dd project to working sets
Select..

LS

Integration: cp- <name of the source product>. For example, cp-bsm

Make sure that after defining you can view the file under the Integration project
icp.dwmodelappintegration file.

Source: cp- <name of the source product>-<version>-<rdbms_type>. For example, cp-bsm-
9.01-ucmdb
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N o o &

Make sure that after defining you can view the file under the Source project
scp.dwmodelappsource file.

Target: cp- <name>

Select the default location or browse to the location of the content folder.
Select Add project to working sets or select your new Working Sets.
Click Next.

Select the relevant Content Pack for the project:

= For new Integration CP select the Target Content Pack for the project.
= Fornew Source CP select the Integration Content Pack for the project.
Click Finish.

Proceed with defining the Architect and Engineer context projects. For details, see "Perform
Architect Context IDE Tasks" on page 18 and "Perform Engineer Context IDE Tasks" on page
27.
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Define the Target Model

Before working with a specific context, you should define the Target model and the related
associations and mappings. The Target model describes the final version of the data that adheres
to the design required by applications. Each table in the model contains both designed columns and
static columns, which comprises the metadata, so that the administrator can have the visibility of
ETL processing over the entity’s data.

Target Model — Dimension or Fact: The target data models describe the format of the data that
produces business intelligence analytics. The instantiated data models are dimension, fact, and
hierarchy tables.

In the Architect context you use this model to link Dimensions and Facts to the Target entity.
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Perform Architect Context IDE Tasks

The Architect context enables you to define a Target entity as well as link associations. Each
Target entity in the Architect context contains columns of fact, or dimension and associations to
other Target entities.

Architect contexts can contain one or more Target entities. Usually each Architect context includes
several entities that are related to the same subject (context). Target entities can be included in
several Architect contexts.

Note: It is recommended to create a separate general project in the Package Explorer for the
Architect context files.

Learn More

The Architect Context enables the following:
o Create a new entity metadata which is translated into the Target model.
o Load an existing Target entity.
o Add columns which affect entity generation.
o Add associations between entities.
= Link a Fact to Dimension

= Link a Dimension to Dimension

Tasks

This section includes:

"To create a new Architect Context in the IDE:" below
"To define a new Target entity:" on next page

"To load an existing Target entity:" on next page

"To add a column: " on next page

"To link a Dimension to a Dimension:" on next page
"Tolink a Fact to a Dimension:" on next page

To create a new Architect Context in the IDE:

1. Inthe IDE main page, select File > New > Other > DWH IDE Wizards > Architect Context
and click Next.

2. Select the parent folder and enter the file name for the context diagram and click Next.

3. Select the relevant Target Content Pack directory and click Finish.
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To define a new Target entity:

1. Inthe Architect Context, in the palette area, select New Target Entity and click on the
canvas.

2. Name the entity.

3. Add relevant columns to the entity.

4. Click = save.

To load an existing Target entity:

1. Inthe Architect Context, in the palette area, select Load Target Entity and click on the
canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously added columns and
dimensions.

3. Add relevant columns to the entity. You can then edit and configure columns in the Properties
view.

4. Click (=] Save.
To add a column:
1. Inthe Architect Context, in the palette area, select Target Column.
2. Click in the Column area of your entity and enter the Column ID in the text box.
The column is added to the entity. You can then edit and configure columns in the Properties

view.

3. Click "= save.
To link a Dimension to a Dimension:

1. Inthe Architect Context, in the palette area, click Dimension to Dimension.
2. Drag the arrow to from a Dimension to the Dimension you want it linked to.

3. The New Dimension to Dimension dialog box opens. The default name is displayed and can be
edited. This relation links a Dimension entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the Associated Dimension.

The default Associated Dimension name is the Target entity.

4. Click ‘= save.

To link a Fact to a Dimension:

1. Inthe Architect Context, in the palette area, click Fact to Dimension.

2. Drag the arrow from the Fact column in the entity to the Dimension you want it linked to .
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3. The New Fact to Dimension dialog box opens. The default name is displayed and can be
edited. . This relation links a Fact entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the associated Dimension.

The default associated dimension name is the Target entity.

4. Click (= Save.

Ul Description

To access:
In the IDE main page, Select File > New > Other > DWH IDE Wizards > Architect Context.

Architect Context Wizard

[ = Mew EISE i
Select a wizard ——
Mifizards:

type filter text
(& Class -

i Interface
122 Java Project
& Jawa Project frorm Existing Ant Buildfile
1 Plug-in Project
= General
= CW3
= DW¥H IDE Wizards
o Architect Context
97 Engineer Context
= Content Pack
(= Eclipse Modeling Framework
(= Example EMF Model Creation Wizards
= lava
(= Java Emitter Templates
(= Plug-in Developrment
= User Assistance
= Examples >

1

-
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Wizard The context wizard contains:
Map

Select a Wizard > New DW Architect Diagram > Target Content Pack

selection.

New DW Architect Diagram

#

= Mew DW Architect Diagram

Create DWH Architect Diagram
Mo folder specified,

Enter or select the parent folder:

1= cp-alm

1= cp-alm-11-generic
1= cp-alt

=% cp-alt-L0-aracle
1= cp-alt-9.0-oracle
=5 cp-am

1= cp-am-5.1-mssql
1= cp-am-5.1-oracle
=% cp-am-5.2-mssql
1= cp-am-5.2-oracle
1= cp-bsm

1= cp-bsm-0.01-bsm
= rh-ham-9.01-nrrmdh

File name: defaultarchitectcontext_diagram

L

User interface elements are described below:

Ul Element

Description

Enter or select the parent folder

Select the folder from the folder list.

File Name

Enter a file name for your context diagram.
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Target Content Pack selection.

= MNew DWH Engineer Diagram I. (=l m,l

Content Pack A
Sel k directori ./_‘
elect content pack directories (=

Target content pack:
Integration content pack:
Source content pack: Browvse..,

@:‘ Mext = Finish Cancel

b

User interface elements are described below:

Ul Element Description

Target Content Pack Select or browse for the Target Content Pack directory.
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Architect View

il bt g st Sevcn Proect D Contart . Wisdow iy
He-HB . Sy - Bhwm $-0-Q-r BG- & B = @
 Padaget 5708 dngom 2 wn
& oo o o o
| © ot genec £ BUDGETLINE & i
& et «
| okLand: i o NewTorget ity
& coakabance E &, Lord Targesny
= I Togerco
o
L & Toget ttes alet, @
- A Dimension to
€ BUSPROCESS 7 Dimenvion
o A Factta Dimension
Columns (Assodiated Dimensions - -
&2 process nave e Assodiated Dimensions
% &1 sunceTcaeGoRy
2 oescrmon
&7 suocer
& BUSINESS CRITICALITY Y
=
. 5 ocriac
Erisia
=
= 5, susprocess
2 oate crearen "
7, susprocessy
&2 oate MoorED 3
& cpertt-gunaic
| > B pm
R
S cpramt heorace
[Epa -
& cprma e
© et
& cptet 20-genaic
© cprucmd
| 5 coveme 902-uemat
([ Problems [ Properties £3. @) Eror Log =8
€ Target
Genersl iy
Colamns Generltagt entty atrbutes El
iCppesanctl o, BUDGETLINE
Eunes ame: SudoetLines
Ouserption it Budget ines

Dimension

User interface elements are described below (when relevant,

angle brackets):

unlabeled elements are shown in
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Palette Area
ul Description
Element
Target Contains the following Core entity options:
Entity

e L New Target Entity.

. = Load Target Entity. Opens the Resource Selector dialog box. Select the
relevant entity for your model.

i N

Resouce Selector

CORE
PERICD / PERICID
ACTUALCOST / Actual Cost Lines
APPLICATION / Applications
BACKUP_POLICY / Backup Policys
BACKUP_SESSION / Backup Session

m

BUDGET / Budgets

BUDGETLIME / Budget Lines

BUSIMESS_APP_STATUS / Business Application Status

BUSPROCESS / Business Process -
[ oK ] ’ Cancel

° 'I:.I]]Target Column. Adds columns to entities. Column properties, for example
column type, can be edited in the Properties tab.

Each added attribute impacts the relevant entity generations.

Target Click atool to create connections for building the model.
Entities A
Relation | , " pimension to Dimension. Link from one Dimension to another Dimension.

A red arrow is displayed between the entities.

« - Fact to Dimension. Link from a Fact to a Dimension. This type of relation
requires that the fact type was defined in the entity properties. A blue arrow is
displayed between the entities.
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Properties tab for Target entity and specific fields

To view the Properties tab, right-click on the specific entity and click Show Properties View.

You first configure the Target entity properties, and then the properties for each specific column.

Ul Element Description

General tab | Displays the Entity, Dimension and Fact attributes for the target entity.
General Target entity attributes:

e ID: The ID of the entity.

e Business Name: The complete business name.

o Description: Enter a description of the entity.

Dimension attributes:

o Type: Select Primary for a Dimension, select None for a Fact and select the
fact attributes.

¢ Conformed: Select True, False, or None.
Fact attributes:

o Type: Select an attribute for a Fact, select None for a Dimension and select
the Dimension attributes.

Columns Displays information for each column in the Target entity:
tab « ID. The ID of the entity.

o Business name. The complete business name.

o Description. Enter a description of the entity.

o Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time
o Length. Only for Varchar data type.

o Null Allowed. Select if the field can have the value NULL.

o SCD Type. Slowly Changing Dimension type can be either 1 or 2. Only for
Dimension.

SCD1: For update.
SCD2: For preserving history.
o Measure. Select only for Fact.
o Calculation Formula. The calculation of the measure.

o Summary. Select SUM, MIN, MAX, or AVG.

Appearance | Displays font and appearance information.
tab
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Properties tab for Associated Dimensions

To view the Properties tab, right-click on the specific entity and click Show Properties View.

Ul Element Description

Associations tab Displays Dimension association information:

e ID. The ID of the entity.

e Business Name. The complete business name.
o Description. Enter a description of the entity.

o Type. Select Dimension, Fact, or Both.

e SCD Type. For Dimension only.

e From Target. The Target entity.

e To Target. The Associated Dimension

Appearance tab Displays font and appearance information.

New Associated Dimension Dialog Box

When you link to an unlinked Dimension, the following dialog box opens.

= Mew Dimension to Dimension Relation L EE
Insert associated dimension name
BUSPROCESSZ
[ 0] ;8 ] ’ Cancel

Edit an Associated Dimension name. The default is the Target entity name.
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Perform Engineer Context IDE Tasks

The Engineer context enables you to define the integrations and how they are transformed and
connected. This view defines the mapping relations for the entity from the source to the target.

Learn More

The Engineer context enables you to extend and add content from the Integration and Source
Content Packs into the target model. Using a new or existing Target entity, you can add new or
existing content from the Integration and Source entities. You then perform SSI and Source
Integration mapping for new and pre-loaded entities. The Source, Integration and Target entities are
mapped using the SSI Mapping connector, which creates a new SSI mapping entity. All further
mapping is done to the new entity.

Note: All Source entities must be connected to an Integration entity.

Entities in the Engineer context are mapped as follows:

o Source Entity: Mapping to the correct source, meaning the version the data is extracted from.
o Integration Entity: Contains the mapping of all fields.

o Target Entity: Several consolidation entities can be consolidated into one entity.

It is recommended to map from the Source to the Target.

Source Extractors:

OOTB set of existing supported extractors are:
o Generic Extractors
s DB Extractor: Supports MSSQL, Oracle and MySQL databases.
n File Extractor: Supports general CSV file.
o Source Specific Extractor
= BSM API Extractor: Supporting both GDE and REST calls
= DP CLI Extractor
= SA SDK Extractor
= NNM Optimized file Extractor: Holds mass volumes of NNM files.
Connecting to the integration:

ETL Gen templates in the back-end generate integration templates which utilize File Based
Integration (FBI).

Load the Source metadata to the IDE and then map it to the correct consolidation entity in the
relevant fields.
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Important Information

Note: Creating new Target entities with Associated Dimensions can only be done in the
Architect context.

Tasks

This section includes:

"To create a new Engineer Context in the IDE:" below

"To define a new Target entity:" below

"To load an existing Target entity:" below

"To define a new integration entity:" on next page

"Toload an existing integration entity:" on next page

"To define a new source entity:" on next page

"To load an existing source entity:" on next page

"To add a column:" on next page

"To map from the Integration to Target:" on page 30

You can create new integrations based on graphical diagrams, using the Engineer context in the
IDE tool.

To create a new Engineer Context in the IDE:

1.

2.
3.

In the IDE main page, select File > New > Other > DWH IDE Wizards > Engineer Context
and click Next.

Enter or select the parent folder and enter the file name for the context diagram and click Next.

Select the Target, Integration, and Source Content Pack directories and click Finish.

To define a new Target entity:

1.

4.

In the Engineer Context, in the palette area, select New Target Entity and click on the
canvas.

Name the entity.

Add relevant columns to the entity.

Click "= save.

To load an existing Target entity:

1.

In the Engineer Context, in the palette area, select Load Target Entity and click on the
canvas. The Resource Selector dialog box opens.

Select an entity. The entity is displayed with all of the previously added columns and
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dimensions.
3. Add relevant columns to the entity. You can then edit and configure columns in the Properties

view.

4. Click "=/ save.

To define a new integration entity:

1. Inthe Engineer Context, in the palette area, select New Integration Entity in the Integration
section and click on the canvas. An integration entity is displayed.

2. Enteraname. An Integration entity is created.
3. Click Integration Column to add a column to the entity.

4. Perform mapping if required.

5. Click "= Save.

To load an existing integration entity:

1. Inthe Engineer Context, in the palette area, select Load Integration Entity in the Integration
section and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously added mappings.

To define a new source entity:

1. Inthe Engineer Context , in the palette area, select New Source Entity in the Source section
and click on the canvas. An Source entity is displayed.

2. Click Source-Integration Relation and drag the display arrow from the Source entity to an
Integration entity. All columns from the Integration entity are copied to the Source entity with
default values.

3. Click "* Save.

To load an existing source entity:

1. Inthe Engineer Context , in the palette area, select Load Source Entity in the Source section
and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with its mapped integration entity.

To add a column:
1. Inthe Engineer Context, in the palette area, select Target Column or Integration Column.
2. Click in the Column area of your entity and enter the Column ID in the text box.

The column is added to the entity.
3. Click "= save.

Note: Source data is replicated from the integration entity. If you add or delete columns from
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the Integration, however, it is not automatically done in the Source.

To add: Once you have added the column in the properties tab, delete the mapping link and re-
map from the Source to Integration.

To delete: Right-click the deleted column, delete the mapping link and re-map from the Source
to Integration.

To map from the Integration to Target:

Once you have added columns to the Integration entity you can perform SSI mapping.

1. Inthe Engineer Context, in the palette area, click Column Mapping in the Relations section to
map the Integration to the Target entity.

2. Drag the arrow from the Integration column to the Target column.

3. After you have performed the first SSI mapping, a transformation SSI entity is created to which
you can perform further mapping. Any integration entity from the same CP that should be
mapped to this Target, must be mapped to the transformation entity.

4. Click "= save.

Ul Description

To access:
In the IDE main page, Select File > New > Other > DWH IDE Wizards > Engineer Context .
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Engineer Context Wizard

Select a wizard —t

Wizards:

(& Class -

65 Interface g

@ Jawa Project

# Java Project from Existing Ant Buildfile

42 Plug-in Project

= General i

= TS

= DwiH IDE Wizards I
o Architect Context
9 Engineer Context
= Content Pack L

[= Eclipse Modeling Frarmewaork

1

@ < Ba,:k : %NEH - : lesh . j—jcan,:ﬂ

Wizard Map | The context wizard contains:

Select a Wizard > New DW Engineer Diagram > Content Pack selection.
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New DW Engineer Diagram

-
== Mew DWH Engineer Diagram _ E@g

Create DWH Engineer Diagram

B

Select file that will contain diagram model.

Enter or select the parent folder:

Engineer Context

it & =
= cp-ppm-8.0-oracle »
= cp-ppm-9.1-oracle
1= cp-sa
1= cp-5a-9.00-generic
= cp-sm
= cp-sm-7.11-mssql
= cp-sm-7.11-oracle
= cp-sm-9.2-mssq|
= cp-sm-9.2-oracle
= cp-ucmdb
= cp-ucmdb-9.02-ucmdb
1= Engineer Context ]

m

File name:  DEFECT|engineercontext_diagram

@ <Back |[ Nea> ][ Finish

User interface elements are described below:

Ul Element Description
Enter or select the parent folder Enter or select the folder from the folder list.
File Name Enter a file name for your context.
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Content Pack selection

, |

Content Pack

i

Select content pack directories

Select Core CP Directory:

=
!"

Select Integration CP Directory:

=
o

Select Source CP Directony:

@ Next » Finish Cancel

5

User interface elements are described below:

Ul Element Description

Select Target CP Directory: Browse for the Target Content Pack directory.
Select Integration CP Directory: Browse for the Integration Content Pack directory.
Select Source CP Directory: Browse for the Source Content Pack directory.
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Engineer Context

n-Ea S =B B B e B - B B0 A WO @A Lo o @

5 APPLICATION
oRED

LOTEOROT §

z
\ =]

GUEEUTEINERET

5 AM.5.20racle BUSINESS APPLICATION

GUCEUEEETNT

cprucmdb-S02-ucm

MEDIA LCN.ID
et MEDIALOCATION
ign Keyta LOCATION

scor

Palette Area
Ul Description
Element
.I;artgtit o = New Target Entity. Select to display a new Target entity.
nti

. & Load Target Entity. Opens the Resource Selector dialog box. Select the
relevant entity for your model.

r N

Resouce Selector

CORE
PERIOD / PERICD
ACTUALCOST / Actual Cost Lines
APPLICATION / Applications
BACKUP_POLICY / Backup Policys
BACKUP_SESSIONM / Backup Session
BUDGET / Budgets
BUDGETLINE / Budget Lines
BUSIMESS_APP_STATUS / Business Application Status
BUSPROCESS / Business Process -

] »

[ OK ] ’ Cancel

L &

. 'I:.I]]Target Column. Adds columns to entities. Column properties, for example
column type, can be edited in the Properties tab.

Each added attribute impacts the relevant entity generations.
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ul Description
Element
Integration | Contains the following Integration entity options:
Entity .
o G New Integration Entity. Select to display a new Integration entity.
. & Load Integration Entity. Opens the Resource Selector dialog box. Select
the relevant entity for your model.
Resouce Selector )
ALT -
AM i
BSM
DP
T_OBJECT / NODE 2
i T_MEDIA / LOCATION
| T_SESSIOM / T_SESSION 4§
MNA
MMM
PPM .
[ OK ] ’ Cancel ]
° il Integration Column. Adds columns to entities. Column properties, for
example column type, can be edited in the Properties tab.
Each added attribute impacts the relevant entity generations.
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ul Description

Element

Source Contains the following Source entity options:
Entity

« ‘UNew Source Entity. Select to display a new Source entity.

« [BLoad Source Entity. Opens the Resource Selector dialog box.Select the
relevant entity for your model.

Resouce Selector

Ll

> AM.51.mssql -
> AM.51.oracle
> AM.5.2.mssql
- AM.5.2.oracle =
» BSM.9.0L.B5M
> BSM.9.0L.UCMDB il
a DP.6.2.GENERIC

T_MEDIA

T_SESSION
- DP6.2.oracle -

[ ok ][ Concel |

. J’“Source to Integration Relation. The Source must be mapped to the
Integration in order to map to the Target. A blue arrow is displayed between the
entities.

SSi Click to map the displayed entities.

« ./ Column Mapping. Mapping between the Integration and Target columns.
First time mapping is done from the Integration column to the Target column. A
black arrow is displayed between the entities.

First-time mapping creates a new entity for SSI Transformation. Subsequent
mappings are done to the new SSI Transformation entity.
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Properties tab for Integration

To view the Properties tab, right-click on the specific entity and click Show Properties View.
Note: Properties data is replicated in the Integration and Source columns. If you add or delete
columns from the Integration, however, it is not automatically done in the Source.

To add: Once you have added the column in the properties tab, delete the mapping link and re-
map from the Source to Integration.

To delete: Right-click the deleted column, delete the mapping link and re-map from the Source
to Integration.

Ul Element Description
General tab Displays the General entity attributes.
Columns tab Displays column information:

e ID. The ID of the entity.

e Business name. The complete business name.

o Description. Enter a description of the entity.

o Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time
e Length. Only for Varchar data type.

e Null Allowed. Select if the field can have the value NULL.

e Business Key. Primary key of the Integration field order.

Properties tab for Source

To view the Properties tab, right-click on the specific entity and click Show Properties View.

ul Description
Element

General General attributes:
tab .
¢ ID. Theentity ID.

¢ Content Pack. The Source Content Pack information.

Data Source SQL Clauses:

o Group by. The section in the SQL Query for the aggregation.

o Table Name/Join Condition. Default is Integration entity name. If you change
the table name, you must also change it in the columns. Enter the Join Condition
foran SQL query with join.

o Where. Where to extract for the SQL query for filtering data from the source.
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ul Description
Element
Columns | Displays column information. The Source entity receives all of the Integration entity
tab properties.
e ID. The ID of the entity.
o Type. Select Fixed, Direct, or Rule. If you select Fixed, you must enter a Fixed
Value. if you select Rule, you must enter the Calculation Rule.
o Not Applicable.
e Table Name. Based on table name entered in the General tab.
e Column Name. The field name. Must be what appears in the Source entity.
o Fixed Value. The fixed value of the column.
¢ Calculation Rule. The calculation rule of the column.
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Manage Validation

The IDE performs validations on the entities created in the Architect and Engineer contexts. Make
sure all entities have been configured properly according to the following validations:

Validation Source Integration Core

Length of column names Upto 30 Upto 30 Upto 26
characters | characters | characters

Length of entity names Upto 30 Upto 14 Upto 20
characters | characters | characters

Prevent the option to generate JSON before the column type is X

defined (attribute/measure)

Prevent the option to generate JSON before the join/union table X

defined

Prohibit using special characters in the Integration names and in X X X

the columns

Database Constraints:

¢ Length identifier and suffixes must be up to 30 characters.

o First character must be a letter [a-z][A-Z].

o Next characters should be a letter, a digit, or' ', '$', or '#.

e Must not start with one of the DW Platform reserved prefixes:

MD_orDI_.

Make sure that the Business Key is specified. In case of more than X

one Business Key, they must be in order (1, 2, 3) without spaces in

the numbering.

Make sure that the column ID is unique. X X
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Generate the ETL

You can generate the relevant schemas and ETLs that are required for the integration.

ETL Gen generates the required artifacts based on the modeling in the previous steps. The artifacts
contain BODS workflows that are imported into the BODS repository as well as data models XML
files that are imported into the Data Warehouse metadata repository. Once the metadata has been
loaded, the schema generation mechanism performs the schema changes in the target and the
staging databases.

To create a new entity with the ETL Gen:
1. Click M to generate the JSON file from your entities.
2. Install the ETL-Gen from the IDE DVD (IDE Prerequisite).

a. Open Apache Tomcat folder. It is recommended to use the Apache Tomcat that is installed
on the DWH server.

b. Copy the ETL-Gen WAR file to the webapps folder of the Apache Tomcat directory.

c. Restart Apache Tomcat. A new folder called etl-gen-9.30.00-SNAPSHOT is displayed
under the webapps folder of the ETL-Gen folder.

3. Generate the artifacts.

a. Copy the JSON file generated by the IDE to the schema-metadata folder found under the
ETL-Gen folder.

b. Open ETL-Gen Ul in your web browser (Firefox and Chrome are supported) by entering the
following address:

<MACHINE_NAME>:<PORT>/etl-gen-9.30.00-SNAPSHOT/etl-generator.html.
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ETL Generator

@ Usze standard metadata (' Use custom ETL metadata

XS ETL Version 930 ~
XS ETL Path GEN

Product/Source Application B5SM
Product Version 9.01
Entity TESTETL

| Generate ETL |

c. Selectthe XS ETL Version (9.03/9.30), the XS ETL Path (GEN/CUSTOM), and the
Product/Source Application.

d. Enterthe Product Version and Entity name you are adding.
e. Click Generate ETL (this step may take a few seconds).

f. Click Continue (this step may take some time), the generated files name are displayed on
screen.

4. Copy the artifacts.
a. Openthe generated_files folder under the ETL-Gen folder.
b. Copy Content Pack folder to the ContentPacks folder in your DWH installation.
c. Fornew i-CPs:

i. Rundw_ds_automation with register task: dw_cp_register.bat -addInstance —name
<CP_NAME>.

ii. Rundw_ds_automation with deploy task: dw_ds_automation.bat -cp <CP_NAME>
—task Deploy.

iii. Rundw_ds_automation with activate task: dw_ds_automation.bat —cp <iCP name>
—task Activate.

d. For previously activated i-CPs: Run dw_ds_automation with redeploy task.
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o dw_ds_automation.bat —cp <iCP name> —task Redeploy.

o dw_ds_automation.bat —cp Core —task Redeploy.
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